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Preface

This preface describes the document accessibility features and conventions used in this 
guide–Creating Domain Templates Using the Domain Template Builder.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or 
visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1Introduction

This chapter provides an overview of how to create templates by using the Domain 
Template Builder.

Topics include:

■ Section 1.1, "Overview of the Domain Template Builder"

■ Section 1.2, "About Domain and Extension Templates"

■ Section 1.3, "Overview of Creating Domain Templates by Using the Domain 
Template Builder"

■ Section 1.4, "Overview of Creating Extension Templates by Using the Domain 
Template Builder"

■ Section 1.5, "Additional Tools for Creating Templates"

1.1 Overview of the Domain Template Builder
You can create WebLogic domains by using domain and extension templates that 
contain the key attributes and files required for building or extending a WebLogic 
domain. To create domain or extension templates, you use the Domain Template 
Builder, which is a standalone Java application that guides you through the process. 
This process is illustrated in Figure 1–1.

Figure 1–1 Domain Template Builder
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The Domain Template Builder is designed to be used off-line in graphical mode. It is 
not supported in console mode. Therefore, the console attached to the machine on 
which you are using the Domain Template Builder must support Java-based GUIs. All 
consoles for Windows systems support Java-based GUIs; some UNIX-based consoles 
support Java-based GUIs.

Your product installation includes a set of predefined domain and extension templates. 
This set of templates includes the WebLogic Server Base Domain template, and various 
extension templates that allow you to add product features and samples to the base 
domain. For more information on the templates that are available for various products, 
see the Domain Template Reference.

After you create your domain and add new resources and applications to it, you can 
use the Domain Template Builder to create a custom domain template. You can also 
use the Domain Template Builder to customize an existing template. For example, you 
may want to remove applications or add SQL scripts for additional databases. To do 
so, select the existing domain or template as the source for your new custom template. 
When your custom domain templates are complete, you can use them to create 
domains by using the Configuration Wizard, WLST Offline, or the unpack command. 
For more information about these tools, see Section 1.5, "Additional Tools for Creating 
Templates."

1.2 About Domain and Extension Templates
In the context of the Domain Template Builder, the term template refers to a Java 
Archive (JAR) file. A template JAR contains the files and scripts that are needed to 
create or extend a WebLogic domain. The types of templates that can be used by the 
Configuration Wizard to create or extend domains include:

■ Domain template—defines the full set of resources within a WebLogic domain, 
including infrastructure components, applications, services, security options, and 
general environment and operating system options. You can create this type of 
template from an existing domain by using the Domain Template Builder or the 
pack command. You can then create a domain based on the template.

The product distribution includes the WebLogic Server Base Domain template. 
This template defines the core set of resources within a domain, including an 
Administration Server and basic configuration information, infrastructure 
components, and general environment and operating system options. It does not 
include sample applications. You can use this template to create a basic WebLogic 
Server domain, which you can then extend with applications and services, or 
additional product component functionality. 

■ Extension template—defines applications and services that can provide additional 
features, such as applications, or JDBC resources, JMS components, or deployed 
libraries. This type of template can be used to update an existing WebLogic 
domain.

■ Managed Server template—defines the subset (within a domain) of resources that 
are required to create a Managed Server domain on a remote machine. This type of 
template can be created using the pack command. 

Your product installation includes a set of predefined domain and extension templates. 
This set includes the WebLogic Server Base Domain template and various extension 
templates that allow you to add component features and samples to the base domain. 
For more information about these templates and how they relate to each other, see the 
Domain Template Reference.
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1.3 Overview of Creating Domain Templates by Using the Domain 
Template Builder

To create a custom domain template by using the Domain Template Builder, select the 
domain or domain template from which you want to create your new domain 
template. You then have the option to modify the following:

■ Basic template information

■ Application and domain directory contents

■ SQL scripts for database configuration

■ Administration Server and user configuration

■ Basic security configuration, such as creating users, groups, and global roles and 
their assignments

■ Start menu entries (Windows only)

■ Customized scripts and variables

Table 1–1 summarizes the steps for creating a domain template by using the Domain 
Template Builder. These steps are described in detail in Chapter 3, "Using the Domain 
Template Builder to Create Domain Templates."

Table 1–1 Steps for Creating a Domain Template by Using the Domain Template Builder

In This Step You Perform This Action

Create a New Template Choose Create a Domain Template to create a domain template. 

Select a Template 
Domain Source

Select the domain template or the WebLogic domain directory from 
which you want to create a domain template.

Describe the Template Specify a description for the template.

Add or Omit 
Applications

Review and, if necessary, modify the list of applications to be 
included in the template.

Add Files Review and, if necessary, modify the files to be included in the 
template.

Add SQL Scripts Add SQL scripts for each database that you expect to be used with 
the domains created from this template, and specify the order in 
which the scripts are executed.

Configure the 
Administration Server

Define the Administration Server settings, such as listen port and 
whether or not SSL is enabled.

Configure Administrator 
Username and Password

Specify the username and password for the Administration Server. 
Optionally, you can also configure additional security features by 
defining users and groups and assigning them to global security 
roles.

Specify Start Menu 
Entries

Optionally, define entries for the Windows Start menu. 

"Prepare Scripts and Files 
with Replacement 
Variables"

Replace specific paths, filenames, and other domain environment 
settings with replacement variables in text files contained in the 
template. The Configuration Wizard later replaces the variables 
with exact strings to set up a specific WebLogic domain.

Review WebLogic 
Domain Template

Review the settings defined in your template.

Creating Template Specify the name and directory for the domain template, and 
launch the process that creates it.



Overview of Creating Extension Templates by Using the Domain Template Builder

1-4 Oracle Fusion Middleware Creating Domain Templates Using the Domain Template Builder

1.4 Overview of Creating Extension Templates by Using the Domain 
Template Builder

The process of creating an extension template is similar to the process of creating a 
domain template, except that you are not prompted to configure the Administration 
Server, assign an administrator username and password, or specify Start menu entries. 
These domain settings are already defined in the domain you are extending.

To create an extension template, you select a domain or extension template to use as 
the basis for the extension template. You then have the option to modify:

■ Basic template information, such as name and description

■ Application directory contents and location

■ Files to be included in the template

■ SQL scripts for database configuration

■ Additional security, such as creating users, groups, and global roles

■ Customized scripts and variables

The Domain Template Builder creates an extension template (JAR file) that can be used 
to extend an existing WebLogic domain.

Table 1–2 summarizes the steps for creating an extension template. These steps are 
described in detail in Chapter 4, "Creating Extension Templates by Using the Domain 
Template Builder."

Table 1–2 Steps for Creating Extension Templates by Using the Domain Template 
Builder 

In this step You

Create a New 
Template

Choose Create an Extension Template to create an extension 
template. 

Select a Template 
Domain Source

Choose an extension template or a WebLogic domain directory from 
which you want to create the extension template.

Describe the Template Enter a description for the template. If you select an existing template 
as your source, the description for that template is displayed. Review 
the description, and modify it if necessary.

Add or Omit 
Applications

Review and, if necessary, modify the list of applications to be included 
in your extension template.

Add Files Review and, if necessary, modify the list of files to be included in your 
extension template.

Add SQL Scripts Add SQL scripts for each database that you expect to be used with the 
domains created from this template and specify the order in which the 
scripts are executed.

Security Configuration 
Options

Optionally, create users, groups, and roles; then, assign them to 
groups and global roles.

Prepare Scripts and 
Files with 
Replacement Variables

Replace specific paths, filenames, and other environment-specific 
strings with replacement variables in text files contained in the 
template. Later, when a specific WebLogic domain is being created, 
the Configuration Wizard replaces these variables with exact strings.

Review WebLogic 
Extension Template 
Settings

Review the settings defined in your template.
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1.5 Additional Tools for Creating Templates
As described earlier, you can create custom domain and extension templates by using 
the Domain Template Builder. You can also use the following tools to create templates:

■ pack

This command enables you to create a template archive (JAR file) that contains a 
snapshot of either an entire WebLogic domain or a subset of a WebLogic domain. 
You can use a template that contains a subset of a domain to create a Managed 
Server domain directory hierarchy on a remote machine.

For more information, see Creating Templates and Domains Using the Pack and 
Unpack Commands.

■ WebLogic Scripting Tool (WLST):

WLST is a command-line scripting interface, which you can use to interact with 
and configure WebLogic Server instances and domains. When WLST is offline, you 
can create a WebLogic domain or update an existing WebLogic domain without 
connecting to a running WebLogic Server—supporting the same functionality as 
the Configuration Wizard. 

For more information, see Oracle WebLogic Scripting Tool and WebLogic Scripting 
Tool Command Reference.

Creating Template Enter a name and directory for the extension template, and launch the 
process that creates it.

Table 1–2 (Cont.) Steps for Creating Extension Templates by Using the Domain 
Template Builder 

In this step You
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2Starting the Domain Template Builder

This section describes how to start the Domain Template Builder.

Starting the Domain Template Builder on a Windows machine
To start the Domain Template Builder on a Windows machine, do one of the following:

■ From the Start menu, choose Start > Programs > Oracle WebLogic > WebLogic 
Server > Tools > Domain Template Builder. 

The Create a New Template window is displayed.

■ From a command prompt window:

1. Go to the common\bin subdirectory of the WebLogic Server installation 
directory.

2. Run the config_builder.cmd command.

Starting the Domain Template Builder on a UNIX machine
To start the Domain Template Builder on a UNIX machine, the console attached to the 
machine on which you are running the Domain Template Builder must support 
Java-based GUIs.

1. Log on to the target system.

2. Open a command shell.

3. Go to the common/bin subdirectory of the WebLogic Server installation directory.

4. Run the following script:

sh config_builder.sh

Note: The Domain Template Builder can be used only in graphical 
mode. To create templates from the command line, use the pack 
command. For more information, see Creating Templates and Domains 
Using the Pack and Unpack Commands.
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3Using the Domain Template Builder to Create
Domain Templates

The following topics describe how to create a domain template:

■ Section 3.1, "Create a New Template"

■ Section 3.2, "Select a Template Domain Source"

■ Section 3.3, "Describe the Template"

■ Section 3.4, "Specify Template JAR Name and Location"

■ Section 3.5, "Add or Omit Applications"

■ Section 3.6, "Add Files"

■ Section 3.7, "Add SQL Scripts"

■ Section 3.8, "Configure the Administration Server"

■ Section 3.9, "Configure Administrator Username and Password"

■ Section 3.10, "Configure Users, Groups, and Global Roles"

■ Section 3.14, "Specify Start Menu Entries"

■ Section 3.15, "Prepare Scripts and Files with Replacement Variables"

■ Section 3.16, "Review WebLogic Domain Template"

■ Section 3.17, "Creating Template"

3.1 Create a New Template
The Create a New Template screen is displayed when you start the Domain Template 
Builder as described in Chapter 2, "Starting the Domain Template Builder."

Table 3–1 describes the options on this screen.

Table 3–1 Options for Creating Templates

Choose this option When you want to

Create a Domain Template Create a template that defines the full set of resources within a 
WebLogic domain, including infrastructure components, 
applications, services, security options, and general 
environment and operating system parameters. 

You can use the template that you create as the basis for creating 
a WebLogic domain, by specifying the template in the 
Configuration Wizard, WLST, or the unpack command.
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Select Create a Domain Template and click Next.

The Select a Template Domain Source screen is displayed.

3.2 Select a Template Domain Source
The Select a Template Domain Source screen lets you choose the domain or domain 
template from which you want to create a new domain template. 

To select an existing WebLogic domain as the source for the new template
1. Select the Select a Domain tab.

2. Navigate to the directory of the WebLogic domain from which you want to create 
a domain template. Valid domain directories are indicated by the Domain 
directory folder icon, shown here.

3. Click Next. 

The Domain Template Builder verifies that the directory you selected contains a 
valid domain. 

The Describe the Template screen is displayed.

To select a domain template as the source for the new template
1. Select the Select a Template tab.

2. From the list of templates displayed in the Templates pane, select a template.

The templates in the list are located in the directory specified in the Locate 
Additional Templates pane. If you want to change the directory, click Browse, and 
then either navigate to the appropriate directory or enter the path manually.

3. Click Next. 

The Describe the Template screen is displayed.

3.3 Describe the Template
Use the Describe the Template screen to provide a description for the template.

Create an Extension 
Template

Create a template that defines applications and services that can 
be used to extend existing WebLogic domains.

You can import applications and services stored in extension 
templates into an existing WebLogic domain by using the 
Configuration Wizard. For more information, see Chapter 4, 
"Creating Extension Templates by Using the Domain Template 
Builder."

Note: If the directory does not contain a valid domain, an error 
message is displayed.

Table 3–1 (Cont.) Options for Creating Templates

Choose this option When you want to
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■ If you selected a WebLogic domain as the source for the new template, enter the 
information required for the domain, and click Next.

■ If you selected a template as the source for the new template, information about 
the selected template is displayed. Review the information, and, if necessary, 
change it to suit the requirements of your domain. When done, click Next.

Table 3–2 describes the fields on the Describe the Template screen. Fields marked with 
an asterisk are required.

3.4 Specify Template JAR Name and Location
From the Specify Template JAR Name and Location screen, you can accept the 
provided default template JAR file name and directory location, or you change them. 
Table 3–3 describes the fields on this screen.

When done, click Next.

3.5 Add or Omit Applications
The Add or Omit Applications screen is displayed only if applications are included in 
the template or domain that you selected.

Note: This description is displayed in the Select a Template pane of 
the Select a Template Domain Source screen.

Table 3–2 Describe the Template

Field Description

*Name Enter a valid name for the domain template. The name must be a string of 
characters, and can include spaces.

*Version Enter a version number for the template, for example, 1.0.0 or 10.3.3.0

Author Enter the name of the author of the template. The author must be a string of 
characters, and can include spaces.

Category Enter the name of the category in which you want this template to be displayed. 
The category must be a string of characters, and can include spaces.

Description Enter a description of the domain template. The description must be a string of 
characters, and can include spaces.

Table 3–3 Specify Template JAR File Name and Location

Field Description

Template jar name This field defaults to a name based on the values you entered in the 
Name and Version fields on the previous screen. If the template name 
includes spaces, they are replaced by a period (.). The Name and 
Version are separated by an underscore (_). For example, if you entered 
"My new domain" for Name and 1.0.0 for Version on the previous 
screen, the JAR file name defaults to my.new.domain_1.0.0.

You can enter another name for the JAR file if you want. The name 
must not include spaces. 

Template location This field defaults to MW_HOME\user_templates, where MW_HOME is the 
Middleware home directory. If you want to store the file elsewhere, 
either enter the full path to the desired directory or click the Browse 
button to select the directory.
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From the Add or Omit Applications screen, you can

■ Review the list of applications that are currently defined in your template source

■ Review the paths of the current and imported applications

■ If necessary, change the relative path for the directory into which applications are 
imported

■ If necessary, omit applications from the list of files to be imported.

By default, the Domain Template Builder includes applications from the domain or 
template you specified as the source for the template that you are creating. For 
example:

■ If you selected a template as the source for the new template, and if the source 
template has a separately defined applications directory, all the application files 
defined in the applications directory are included by default.

■ If you selected a domain as the source for the new template, applications that fulfill 
the following conditions are included by default:

– Applications that are defined in the config.xml file by the app-deployment 
element

– Applications that are not considered internal applications in your product 
installation are included by default

To add applications in (or omit them from) the template:

1. In the Applications pane, review the list of applications to be included in your 
template. By default, all the applications are selected.

The listed applications reside in the directory specified in the Current Application 
Path field. The applications are copied into your template from this location.

2. To change the relative path of the directory into which an application is imported, 
do the following:

a. Select the application in the Applications pane.

b. In the Imported Application Path field, enter the relative path you want to 
use after the application is imported into your template. 

Note: When you create or extend a clustered domain (by using the 
Configuration Wizard or WLST) based on a template that contains 
applications with application-scoped JDBC or JMS resources, you may 
need to perform certain additional steps after creating or extending 
the domain. These steps are needed to ensure that the application and 
its application-scoped resources are targeted and deployed properly. 
For more information about targeting and deploying 
application-scoped modules, see "Deploying Applications and 
Modules with weblogic.deployer" in Deploying Applications to Oracle 
WebLogic Server.
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3. Deselect the check box for any application that you do not want to include in the 
template.

4. Click Next.

The Add Files screen is displayed.

3.6 Add Files
By default, the Domain Template Builder includes files from the WebLogic domain or 
template you specified as the source for the new template.

■ If you selected an existing template as the source for the new template, all files 
from the source template are automatically included. If the existing template 
defines a separate applications directory, the applications in the template are listed 
under the Applications Root Directory in the Current Template View pane.

■ If you selected a domain as the source for your new template, the following files 
and directories are included by default:

– All files in the root directory with the following extensions: .cmd, .sh, .xml, 
.properties, and .ini

– All files with the .pem extension defined in the SSL configuration for your 
domain

– bin directory

– lib directory

– All files in the security directory that are not created automatically during 
domain creation

For example, in WebLogic, XACMLRoleMapperInit.ldift is not created 
automatically, and therefore is included in the template by default when 
creating a template. 

– All files and subdirectories in the config directory that are not included by the 
Domain Template Builder automatically during template creation. For 
example, config.xml and any JDBC and JMS resources defined in config.xml 
are not displayed in the Current Template View pane by default because the 
Domain Template Builder automatically includes them in the template when 
creating the template.

Note: Some of the applications listed in the Applications pane may 
be included with the WebLogic products. You cannot change the 
relative paths for these applications. When you select these 
applications in the Applications pane, the Imported Application Path 
field is replaced by an Internal Application Path field. Because these 
files are installed on your system during your product installation, 
they are not copied into the template at template creation time. When 
you use this template to create a domain, this path points to the 
application files located in your product installation directory.
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You may also need to include other files from your domain or file system that are 
required by the applications.

The Add Files screen lets you to review, add, or remove files in the template.

■ To view the current list of files in your template, expand the Domain Root 
Directory and Applications Root Directory in the Current Template View pane.

■ To add a file, navigate to the file within the File System View pane and select Add 
File. You can use the filters in the Show File Types drop-down list to limit the files 
displayed in this pane. For example, to display only files with the .cmd extension, 
select *.cmd from the drop-down list.

■ To remove a file, select the file from the Current Template View pane, and select 
Remove File.

After adding and removing files as necessary, click Next.

The Add SQL Scripts screen is displayed.

3.7 Add SQL Scripts
You can add your own SQL scripts to the new template, so that the scripts are 
available when you create a WebLogic domain based on the template.

The Add SQL Scripts window lets you add SQL scripts for each database that you 
expect to be used with the WebLogic domains created from this template. You can also 
specify the order in which the scripts are executed. When you create a WebLogic 
domain based on this template, the databases and associated SQL scripts that you 
include are displayed on the Run Database Scripts screen of the Configuration Wizard.

Note: By default, the servers directory is not included in the 
template. If you have configured additional security data such as 
users, groups, or roles, through the WebLogic Server Administration 
Console or other online tools, it is stored in the LDAP server and is 
not included in the template. You must export the data first and then 
import it into the target domain.

Note: You cannot remove files shown in red or their parent 
directories as they consist of the applications defined in the 
config.xml file in the template source. These files are included by 
default in the template being created. If you do not want these files 
included in your template, you must remove the application with 
which they are associated. To do so, click Previous to return to the 
Add or Omit Applications screen and deselect the appropriate check 
box for the application. 

If you attempt to add a file that is created automatically by the 
Configuration Wizard at domain creation time, an error message is 
displayed.

Note: SQL scripts that are included with the product do not need to 
be added to the template.
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To add SQL scripts to the template:
1. In the Database Type and Version pane, select a database from the Type 

drop-down list.

2. Select the database version from the Version drop-down list or enter a version 
number directly in the field.

3. Click Add SQL File.

The Open dialog box is displayed.

4. Navigate to the directory that contains the SQL scripts for the selected database.

5. Select the SQL files to be added, and click Add SQL File(s).

The SQL files that you added are displayed in the Selected SQL Files pane. The 
Selected Database Scripts pane displays a tree-view of all the databases and 
associated SQL scripts included in the template.

You can change the order in which the SQL files are executed by using the Up and 
Down arrow icons. The specified sequence is reflected in the Selected Database 
Scripts pane.

6. Repeat steps 1 through 5 for each database for which you want to include SQL 
files.

7. Click Next.

To remove SQL scripts from the template:
1. From the Type drop-down list in the Database Type and Version pane, select the 

database for which you want to remove SQL scripts.

2. Select the database version from the Version drop-down list or enter a version 
number directly in the field.

The SQL scripts for the selected database displayed in the Selected Database 
Scripts pane are listed in the Selected SQL Files pane.

3. In the Selected SQL Files pane, select the SQL file to be removed and click 
Remove SQL File.

4. Repeat steps 1 through 3 for each SQL script that you want to remove.

5. Click Next.

The Configure the Administration Server screen is displayed.

3.8 Configure the Administration Server
In every WebLogic domain, one server must be designated as the Administration 
Server. The Administration Server is the central point from which the entire domain is 
managed.

Note: If you use a template as the basis for the new template, SQL 
files that are included in the source template are displayed in the 
Selected Database Scripts pane, organized by database type.

Note: If you are creating an extension template, the Security 
Configuration Options screen is displayed next. For more information, 
see Section 4.8, "Security Configuration Options."
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You can access the Administrator Server by using the following URL:

protocol://listen-address:listen-port

The protocol can be any of the following: t3, t3s, http, https.

You can define the listen-address and listen-port for the Administration Server on 
the Configure the Administration Server screen of the Domain Template Builder.

For information about the fields on the Configure the Administration Server screen, 
see "Configure the Administration Server" in Creating Domains Using the Configuration 
Wizard.

After configuring the Administration Server, click Next.

The Configure Administrator Username and Password screen is displayed.

3.9 Configure Administrator Username and Password
When you create a domain template, the administrator username and password from 
the original WebLogic domain or template are included in your new template. If 
necessary, you can modify this username and password.

You can also provide extra security for application resources using the following 
security features:

■ Users and groups: Classification of individuals and groups of individuals who 
may be granted a security role. Typically, a group is a collection of users who share 
a role or function within a company, such as working in the same department.

■ Global security roles: Dynamically computed privileges that are used to restrict 
access to WebLogic resources. These privileges are granted to or withheld from 
users according to the roles that they are assigned.

To modify the administrator username and password:

1. Specify a valid username in the Username field. This name is used to start the 
Administration Server and connect to it. User names are case sensitive.

Do not use commas or any characters in the following comma-delimited list:

 \t, < >, #, |, &, ?, ( ), { }

2. Specify a valid password in the User password field. A valid password must 
contain at least eight case-sensitive characters and at least one numeric character. 
The password value is encrypted.

3. Re-enter the password in the Confirm user password field.

4. Optionally, enter a login description for this username. 

5. If you want to configure additional users, groups, and global roles, select Yes at 
the bottom of the screen, and click Next. The Configure Users, Groups, and Global 
Roles screen is displayed.

If you do not want to configure additional users, groups, and global roles, select 
No, and click Next. The Specify Start Menu Entries screen is displayed (see 
Section 3.14, "Specify Start Menu Entries."

3.10 Configure Users, Groups, and Global Roles
The Configure Users, Groups and Global Roles screen is displayed in the Domain 
Template Builder in the following situations:
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■ You are creating a domain template and you selected the option to configure users, 
groups, and global roles on the Configure Administrator Username and Password 
screen. 

■ You are creating an extension template and you selected Yes on the Security 
Configurations Option screen.

Users, groups, and global roles are defined as follows:

■ A user is an entity that can be authenticated. The user can be a person or a 
software entity, such as a Java client. Each user is given a unique identity within a 
security realm.

■ A group is a collection of users who usually have something in common, such as 
that they are working in the same department in a company.

■ A security role is a privilege granted to users or groups based on specific 
conditions. Like groups, security roles allow you to restrict access to WebLogic 
resources for multiple users simultaneously. A security role that applies to all 
WebLogic resources deployed within a security realm (and, thus, within the entire 
WebLogic domain) is called a global role.

The Configure Users, Groups and Global Roles screen lets you define users, groups, 
and roles for authentication purposes. You must define at least one user.

To configure users, groups, and global roles:

1. Select the User tab and review the current user configuration. Add or change 
entries as required for your domain. To delete a user, click in any of the fields of 
the relevant row, and click Delete.

2. Select the Group tab and review the current group configuration. Add or change 
the entries required for your domain. To delete a group, click in any of the fields of 
the relevant row, and click Delete.

3. Select the Role tab and review the current role configuration. The predefined list 
of WebLogic Server global security roles is displayed. Add or change the entries 
required for your domain by using the guidelines provided in Table 3–4. To delete 
a role, click in any of its fields of the relevant row, and click Delete.

Note: Depending on the template or domain you selected, one or 
more users, groups, or roles may be defined already. In addition, 
WebLogic Server defines a default set of groups and roles. For a list of 
the default groups and roles defined in WebLogic Server, see "Users, 
Groups, and Security Roles" in Securing Resources Using Roles and 
Policies for Oracle WebLogic Server.

Note: Do not make the default global security roles for 
administrative and server resources more restrictive. If you eliminate 
any existing security roles, you risk degrading WebLogic Server 
operation. You can, however, make the default security roles more 
inclusive (for example, by adding new security roles).
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When you finish your updates, click Next.

The Assign Users to Groups screen is displayed.

3.11 Assign Users to Groups
The Assign Users to Groups screen lets you assign users to groups. It is recommended 
that you add users to groups. By managing groups, you can manage multiple users 
more efficiently.

1. In the Group pane, select the group to which you want to assign users.

The current assignments for the selected group are displayed in the left pane.

2. In the right pane, do one of the following:

■ To assign a user to the selected group, select the check box for the user. 

■ To remove a user from the selected group, clear the check box for the user. 

To select all users in the list, click Select All. To deselect all users in the list, click 
Unselect All.

The list of groups associated with each user is updated to reflect the changes.

3. Repeat steps 1 and 2 for each user that you want to assign to a group. You can 
assign a user to more than one group.

4. Click Next.

The Assign Groups to Groups screen is displayed.

3.12 Assign Groups to Groups
The Assign Groups to Groups screen lets you designate one group as a subgroup of 
another, to refine management of security for your domain. 

1. In the Group pane, select the group to which you want to assign a subgroup.

The current assignments for the selected group are displayed in the left pane.

2. In the right pane, do one of the following:

Table 3–4 Configure Users, Groups and Global Roles

Field Description

Name* Enter a valid name for the role. Security role names are case sensitive. Do not 
use blank spaces, commas, hyphens, or any characters in the following 
comma-delimited list:

 \t, < >, #, |, &, ~, ?, ( ), { }

The default value in this field is new_Role_n, where n specifies a numeric value 
that is used to differentiate among all default role names; the value of n for the 
first role is 1. The value is incremented by 1 for each role that is added.

Description Enter a description of the role to be used for informational purposes only

Note: You should not assign groups recursively. For example, do not 
assign groupA as a subgroup of groupB and groupB as a subgroup of 
groupA.
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■ To assign a group as a subgroup of the selected group, select the check box for 
the group.

To select all groups in the list, click Select All.

■ To remove a subgroup from the selected group, deselect the check box for the 
group.

To unselect all groups in the list, click Unselect All.

The list of subgroups associated with each group is updated to reflect your 
changes.

3. Repeat steps 1 and 2 for each group that you want to designate as a subgroup. You 
can make a group a subgroup of more than one group.

4. Click Next.

The Assign Users and Group to Global Roles screen is displayed.

3.13 Assign Users and Groups to Global Roles
The Assign Users and Groups to Global Roles screen prompts you to assign users and 
groups to the global security roles defined by WebLogic Server. For a list of the default 
roles and the privileges that users or groups in these security roles are granted, see 
"Default Global Roles" in Securing Resources Using Roles and Policies for Oracle WebLogic 
Server.

1. In the Role pane, select the global role to which you want to assign users and 
groups.

The current assignments for the selected role are displayed in the left pane.

2. In the right pane, do one of the following:

■ To assign a user or group to the selected role, select the associated check box.

To select all users and groups in the list, click Select All. 

■ To remove a user or group from the selected role, clear the associated check 
box. 

To unselect all users and groups in the list, click Unselect All. 

The Role list corresponding to each user and group is updated to reflect the global 
roles to which the user and group are assigned.

3. Repeat steps 1 and 2 for each user or group that you want to assign to a global 
role. You can assign a user or group to more than one global role.

4. Click Next.

The Specify Start Menu Entries screen is displayed.

Note: You must assign one or more users or groups (containing one 
or more users) to the administrator role to ensure that there is at least 
one user who can start WebLogic Server.
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3.14 Specify Start Menu Entries
The Specify Start Menu Entries screen prompts you to create items to be added to the 
Windows Start menu. 

The next step depends on the source for the new template that you are creating.

■ If you selected a WebLogic domain as the source for the new template, Start menu 
entries are not defined. To create Start menu entries for the domain, enter the 
required information and click Next. The required information is defined in 
Table 3–5.

■ If you selected a template as the source for your custom template, the Start menu 
entries from the selected template are displayed here. Review the information and, 
if necessary, modify it to meet the requirements of your domain, as described in 
Table 3–5. 

Add, modify, or delete entries as required by your domain, using the guidelines 
provided in Table 3–5.

To delete an entry, click the tab for the Start menu entry, and click Delete.

When you finish updating your settings, click Next.

The Prepare Scripts and Files with Replacement Variables screen is displayed.

Note: If you are creating an extension template, the Prepare Scripts 
and Files with Replacement Variables screen that is displayed next. 
For more information, see Section 3.15, "Prepare Scripts and Files with 
Replacement Variables."

Table 3–5 Specify Start Menu Entries

Field Description

Shortcut link 
name

Enter a valid name for the shortcut to be displayed in the Start menu. The 
name must be a string of characters and it may include the space character.

Program Specify the program to be run when the shortcut is selected. A list of the 
programs defined by the template source is shown in the drop-down list. To 
use a predefined program, select it from the drop-down list. 

To specify an alternate program, enter the relative path to it in this field. To 
ensure that the template is portable, you can use variables such as $USER_
INSTALL_DIR$ and $DOMAIN_DIRECTORY$ to specify your program path. For 
example:

$USER_INSTALL_DIR$\server\bin\installNodeMgrSvc.cmd.

Note: Do not specify any executable or script that does not reside in the MW_
HOME directory.

Argument Enter any parameter that you want to pass to the shortcut program.

Working 
directory

Enter the path of the directory from which the shortcut will be executed. If you 
have selected a program from the drop-down list in the Program field, this 
field is not available.

Note: By default, the working directory is the directory that contains the 
executable or script. In most cases, you do not need this field. 

Description Enter a description for the shortcut.
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3.15 Prepare Scripts and Files with Replacement Variables
When you are creating a template, you want the scripts and files that you are 
packaging with your template to be free of local domain environment settings and 
ready for use by the Configuration Wizard. The Domain Template Builder 
automatically updates any standard scripts included in a template (such as start 
scripts) by replacing hard-coded values for various domain environment settings with 
replacement variables. The Configuration Wizard can replace these variables with new 
hard-coded values during the configuration of a new WebLogic domain.

The Prepare Scripts and Files with Replacement Variables screen enables you to 
replace hard-coded strings with replacement variables in files that have not been 
updated by the Domain Template Builder.

To insert replacement variables into your files:

1. Open the file in one of the following ways:

■ Double-click the appropriate filename in the Select File list. 

■ Select the appropriate filename in the list and click Edit.

The Instructions pane is replaced by an Edit File pane, in which the file is 
displayed. An editing toolbar is provided at the top of the Edit File pane.

2. To insert a replacement variable:

a. Select the string to be replaced.

b. Click the right mouse button. A list of replacement variables is displayed.

c. Select the required variable.

The replacement variable replaces the selected string. The Configuration Wizard 
later substitutes literal strings for the replacement variables to set up a specific 
WebLogic domain. For definitions of the available replacement variables, see 
Section 3.15.1, "Replacement Variable Definitions."

3. Repeat steps 1 and 2 for each string for which you want to substitute a variable. 

4. Review the changes and click Save to preserve your changes, or Revert to replace 
the current version of the file with the last saved version. If you edited the file 
since the last time you saved it, you are prompted to confirm the revert operation.

5. If you saved the edited file, select the check box next to the filename in the Select 
File pane.

6. Repeat steps 1 through 5 for each file in which you want to insert replacement 
variables.

7. Click Next.

The Review the Domain Template screen is displayed (see Section 3.16, "Review 
WebLogic Domain Template").

Note: The check boxes of files that were automatically updated by 
the Domain Template Builder are selected.

Note: You can also click Reset in the Select File pane to revert to the 
saved version of the file.
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3.15.1 Replacement Variable Definitions
The following table defines the replacement variables most commonly used in files.

Table 3–6 List of Replacement Variables 

Variable Definition

ADMIN_SERVER_URL URL specifying the listen address (host name or IP address) and port 
number of the Administration Server for the WebLogic domain. 

APPLICATIONS_
DIRECTORY

Directory containing the applications required by the domain. By 
default, the pathname for this directory is MW_HOME\user_
projects\applications\domain.

BEA_HOME The Middleware Home directory (MW_HOME) in which the products 
associated with the domain are installed. On a Windows system, the 
default path for this directory is C:\Oracle\Middleware.

DOCSWEBROOT The URL specifying the location of the product documentation on 
the Internet.

DOMAIN_HOME Directory in which the domain resides.

DOMAIN_NAME Name of the domain.

DOMAIN_USER Administration username required to start the server.

JAVA_HOME Location of the JDK used to start WebLogic Server.

JAVA_VENDOR Vendor of the JVM, for example, Oracle, HP, and IBM. 

JAVA_VM Mode in which you want the JVM to run, such as -jrockit, -server, 
-hotspot.

LISTEN_PORT Port to be used to listen for regular, non-secure requests (through 
protocols such as HTTP and T3). The default value is 7001.

PRODUCTION_MODE Mode in which the server is started. If this variable is set to true, the 
server starts in production mode; if set to false, the server starts in 
development mode. 

SAMPLES_HOME Directory containing the samples provided with your product 
installation. By default, the path name for this directory is MW_
HOME\wlserver_version\samples.

SERVER_HOST Name or address of the machine hosting the server. 

SERVER_NAME Name of the server to be started.

SERVER_PORT Port to be used to listen for regular, non-secure requests (through 
protocols such as HTTP and T3). The default value is 7001. 

SSL_PORT Port to be used to listen for secure requests (through protocols such 
as HTTPS and T3S). The default value is 7002.

STARTMODE Mode in which the server is started: development or production.

USERDOMAIN_HOME Directory containing the user domains created with the 
Configuration Wizard. By default, the path for this directory is MW_
HOME\user_projects\domains.

WL_HOME Root directory of your WebLogic Server installation. By default, this 
directory is defined as MW_HOME\wlserver_version.

WLW_INSTALL_DIR Root directory of your WebLogic Workshop installation. By default, 
the path for this directory is MW_HOME\workshop_version.
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3.16 Review WebLogic Domain Template
The Review WebLogic Domain Template screen lets you review the settings for the 
new template before it is created.

1. Select an item in the Template Summary pane on the left and review the 
associated details in the Details pane on the right. If you need to change any 
settings that you defined in previous windows, select Previous to return to the 
required configuration window.

2. Click Create.

The Creating Template screen is displayed.

3.17 Creating Template
The Creating Template screen displays status messages during the template creation 
process. The Domain Template Builder generates a JAR file that contains all the 
components required to generate a new WebLogic domain, including the template 
settings that you provided.

When the process completes, click Done to exit the Domain Template Builder.

The files included in a template vary, depending on the WebLogic domain or template 
on which the template is based. For example, if you specify any Start menu entries in 
the Specify Start Menu Entries screen, a startmenu.xml file that contains the specified 
entries is included in the template. When you use this template to create a domain, 
Start menu entries are created by using the values specified in this file. For more 
information, see "Files Typically Included in a Template" in the Domain Template 
Reference.

Note: You can limit the type of information displayed in the 
Template Summary screen by using the View drop-down list.



Creating Template

3-16 Oracle Fusion Middleware Creating Domain Templates Using the Domain Template Builder



4

Creating Extension Templates by Using the Domain Template Builder 4-1

4Creating Extension Templates by Using the
Domain Template Builder

The process for creating an extension template is similar to the process for creating a 
domain template, except that you do not configure the Administration Server, assign 
an administrator username and password, or specify Start menu entries, because these 
domain settings are already defined in the domain you are extending.

The following topics describe the steps for creating an extension template:

■ Section 4.1, "Create a New Template"

■ Section 4.2, "Select a Template Domain Source"

■ Section 4.3, "Describe the Template"

■ Section 4.4, "Specify Template JAR Name and Location"

■ Section 4.5, "Add or Omit Applications"

■ Section 4.6, "Add Files"

■ Section 4.7, "Add SQL Scripts"

■ Section 4.8, "Security Configuration Options"

■ Section 4.9, "Prepare Scripts and Files with Replacement Variables"

■ Section 4.10, "Review WebLogic Extension Template Settings"

■ Section 4.11, "Creating Template"

4.1 Create a New Template
The Create a New Template screen is displayed when you start the Domain Template 
Builder as described in Chapter 2, "Starting the Domain Template Builder."

Select Create an Extension Template and click Next.

The Select a Template Domain Source screen is displayed.

4.2 Select a Template Domain Source
The Select a Template Domain Source screen lets you choose the application template 
or domain directory from which you want to create an extension template.

To select an extension template as the source for the new extension template
1. Select the Select a Template tab.
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2. Select a template from the Templates list.

The templates are grouped by category.

The extension templates displayed in the list are located in the directory specified 
in the Locate Additional Templates pane. If you want to change the directory, 
either enter the path, or click Browse and then navigate to the appropriate 
directory.

3. Click Next. A Progress dialog box is displayed while the template is being 
prepared. 

When this process completes, the Describe the Template screen is displayed. 
Proceed to the next section.

To select a WebLogic domain as the source for the new extension template
1. Select the Select a Domain tab.

2. Navigate to the domain directory from which you want to create an extension 
template and select the desired WebLogic domain.

Valid domain directories are indicated by a Domain directory folder icon. 

3. Click Next. A Progress dialog box is displayed while the template is being 
prepared. 

When this process completes, the Describe the Template screen is displayed.

4.3 Describe the Template
The Describe the Template screen prompts you to provide a description for the 
template.

■ If you selected a template as the source for the new template, information about 
the selected template is displayed. Review the information, and, if necessary, 
change it to suit the requirements of your WebLogic domain. Then, click Next.

■ If you selected a WebLogic domain as the source for the new template, enter the 
information required for the domain, and click Next.

For information about the fields in the Describe the Template screen, see Table 3–2.

The Add or Omit Applications screen is displayed.

4.4 Specify Template JAR Name and Location
From the Specify Template JAR Name and Location screen, you can accept the 
provided default template JAR file name and directory location, or you change them. 

For more information on these fields, see Table 3–3.

When done, click Next.

Note: The description that you provide here is displayed in the 
Select a Template pane of the Select a Template Domain Source 
screen.
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4.5 Add or Omit Applications
On the Add or Omit Applications screen, you can

■ Review the list of applications that are currently defined in your template source

■ Review the path names of the current and imported applications

■ If necessary, change the relative directory into which applications are imported

■ If necessary, omit applications from the list of files to be imported.

For more information, see Section 3.5, "Add or Omit Applications."

After performing the required steps, click Next. The Add Files screen is displayed. 

4.6 Add Files
By default, the Domain Template Builder includes files from the domain or extension 
template that you specified as the source for the new extension template. On the Add 
Files screen, you can review, add, and remove files in the template.

For more information, see Section 3.6, "Add Files."

After performing the required steps, click Next. The Add SQL Scripts screen is 
displayed.

4.7 Add SQL Scripts
On the Add SQL Scripts screen, you can add SQL scripts for each database that you 
expect to be used with the WebLogic domains that you extend using this template. You 
can also specify the order in which the scripts should be executed. For more 
information, see Section 3.7, "Add SQL Scripts."

After performing the required steps, click Next. The Security Configuration Options 
screen is displayed.

4.8 Security Configuration Options
Optionally, you can configure security parameters for the application resources within 
the WebLogic domain. You can use the following security features to provide security 
for an application resource:

■ Users and groups: Classification of individuals and groups of individuals who 
may be granted a security role. Typically, a group is a collection of users who share 
a role or function within a company, such as working in the same department. 

■ Global security roles: Dynamically computed privileges that are used to restrict 
access to WebLogic resources. These privileges are granted to or withheld from 
users according to the roles to which they are assigned. 

For example, to leverage individual skills, many Web development teams divide 
system administration responsibilities into distinct roles. A team may then assign a 
different level of permission to each role. Each project might give only one or two 
team members permission to deploy components, but allow all team members to 
view the WebLogic Server configuration. 

WebLogic Server supports such role-based development by providing four default 
global roles: Admin, Deployer, Operator, and Monitor. These roles determine 
access privileges for system administration operations.
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On the Security Configuration Options screen, you can set security options for your 
application.

■ If you choose No, the security settings for the new extension template are the same 
as the settings defined in the source template or WebLogic domain.

■ If you choose Yes, additional screens are displayed to let you configure the 
security options, as described in Table 4–1.

4.9 Prepare Scripts and Files with Replacement Variables
The Domain Template Builder automatically updates any standard scripts included in 
a template, such as start scripts, by replacing hard-coded values for various domain 
environment settings with variables. The Configuration Wizard can later replace these 
variables with new hard-coded values during the configuration of a new WebLogic 
domain. 

If you want, you can prepare additional files to be included with your template by 
manually inserting replacement variables. For more information, see Section 3.15, 
"Prepare Scripts and Files with Replacement Variables."

After performing the required steps, click Next. The Review WebLogic Extension 
Template screen is displayed.

4.10 Review WebLogic Extension Template Settings
In the Review WebLogic Extension Template screen, you can review the settings for 
the new extension template before it is created.

1. Select an item in the Template Summary pane on the left and review the associated 
details in the Details pane on the right. If you need to change any settings that you 
defined in previous windows, select Previous to return to the required 
configuration window.

Note: Do not make the default global security roles for 
administrative and server resources more restrictive. If you eliminate 
any existing security roles, you risk degrading WebLogic Server 
operation. You can, however, make the default security roles more 
inclusive (for example, by adding new security roles).

Table 4–1 Security Configuration Options Window - Parameters 

Task Description

Configure users, groups, 
and global roles 

Define users, groups, and global roles for authentication purposes. 
For instructions, see Section 3.10, "Configure Users, Groups, and 
Global Roles."

Assign users to groups Assign users to groups. Groups allow you to manage multiple 
users at the same time. This is generally more efficient than 
managing each user individually. For instructions, see Section 3.11, 
"Assign Users to Groups."

Assign groups to groups Designate a group as a subgroup of another group, to add further 
granularity to security management. For instructions, see 
Section 3.12, "Assign Groups to Groups."

Assign users and groups 
to global roles 

Assign users and groups to predefined WebLogic Server global 
security roles. For instructions, see Section 3.13, "Assign Users and 
Groups to Global Roles."



Creating Template

Creating Extension Templates by Using the Domain Template Builder 4-5

2. Click Create.

3. The Create an Extension Template screen is displayed.

4.11 Creating Template
The Creating Template screen displays status messages during the template creation 
process. The Domain Template Builder generates a JAR file that contains only the 
applications and services specified in the extension template.

When the process completes, click Done to exit the Domain Template Builder.

Note: You can use the View drop-down list to limit the type of 
information displayed on the Template Summary screen.
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5How Do I?

This section provides information and examples for some common template creation 
tasks:

■ Section 5.1, "How Do I Create a Custom Domain Template?"

■ Section 5.2, "How Do I Create a Custom Extension Template?"

5.1 How Do I Create a Custom Domain Template?
The following example explains how to use the Avitek Medical Records Sample 
Domain to create a custom domain template. A domain template defines the full set of 
resources within a domain, including infrastructure components, applications, 
services, security options, and general environment and operating system parameters. 
Once you have created this sample domain, you can then use this template as input to 
the Configuration Wizard to create a Medical Records sample domain.

1. Start the Domain Template Builder.

■ On Windows, from the Start menu, choose Start > Programs > Oracle 
WebLogic > WebLogic Server > Tools > Domain Template Builder.

■ On UNIX:

– Go to the WebLogic Server /common/bin subdirectory:

cd MW_HOME/wlserver_10.3/common/bin

– Enter the following command: 

sh config_builder.sh

2. On the Create a New Template screen, select Create a Domain Template, and click 
Next. 

3. On the Select a Template Domain Source screen:

a. Select the Select a Domain tab.

b. Navigate to the following directory:

MW_HOME\wlserver_10.3\samples\domains

where MW_HOME is the Middleware home directory (the default is 
C:\Oracle\Middleware\).

Note: This example is based on the assumption that you have 
installed the WebLogic Server samples while installing the product.
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c. Select the medrec domain.

d. Click Next.

4. On the Describe the Template screen, fill in each field and click Next.

For this example, enter the following information.

■ Name—Avitek Medical Records Sample Domain

■ Version—10.3.3 (or accept the displayed default)

■ Author—Oracle Corporation

■ Category—Oracle

■ Description—Create the Avitek Medical Records domain in a directory 
outside of the installed kit. The Avitek Medical Records is a WebLogic Server 
sample application suite that concisely demonstrates all aspects of the Java EE 
platform.

5. On the Enter the name and location of the domain template screen, enter the 
following information or accept the defaults:

■ Template jar name—Enter the name you want to use for the template’s JAR 
file, or accept the displayed default, which is based on the name you entered 
on the previous screen.

■ Template location—Accept the default (MW_HOME\user_templates) or enter 
another directory location.

6. On the Add or Omit Applications screen, you can omit applications from the 
template and, if applicable, change the relative path of the directory into which 
applications are imported. By default, all applications in the domain are selected, 
indicating that they will be added to the template.

The applications in this domain are included with the WebLogic Server software. 
Therefore, you cannot change the relative path of the directory into which they are 
imported. Because these applications reside on your system, they are not copied 
into the template.

For this example, leave all applications selected, and click Next.

7. On the Add Files screen, you can add or remove files from the template. By 
default, the following files and directories are included in the template:

■ All files in the root directory with the following extensions: .cmd, .sh, .xml, 
.properties, and .ini.

■ bin directory

■ lib directory

■ All files in the security directory that are not created automatically during 
domain creation. For example, DefaultRoleMapperInit.ldift and 
XACMLRoleMapperInit.ldift are not included by default.

Note: If the template you are creating is to be used as the source for a 
new template, the information you provide in this window is 
displayed in the Select a Template section of the Select a Template 
Domain Source screen. 
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■ All files and subdirectories in the config directory that are not included 
automatically by the Domain Template Builder during template creation. For 
example, config.xml and any JDBC and JMS resources defined in config.xml 
are not displayed in the Current Template View pane by default because the 
Domain Template Builder automatically includes them in the template during 
template creation.

If there are other files on your system that are required for deployed applications, 
you can add them in this window.

The medrec template does not contain any additional files to add. Click Next to 
continue.

8. On the Add SQL Scripts screen, you can add SQL scripts for each database that 
you expect to use with the domains created from this template. 

The Medical Records sample uses the default Derby demo database included with 
your product installation; so you do not need to add SQL scripts in this example.

 Click Next to continue.

9. On the Configure the Administration Server screen, define the configuration 
information for the Administration Server. For more information, see Section 3.8, 
"Configure the Administration Server."

In this example, leave the default values selected and click Next. 

10. On the Configure Administrator Username and Password screen, you can specify 
the username and password that is used to start and connect to the Administration 
Server. 

By default, the username/password combination for the Medical Records domain 
is weblogic/welcome1. You can configure additional users, groups, and global 
roles.

For this example, accept the default settings, and click Next.

11. On the Specify Start Menu Entries screen, you can create entries for the Windows 
Start menu. In this example, you create entries to start and stop the Medical 
Records server.

To create a Start menu entry for starting the Medical Records server:

a. Click Add.

b. In the Shortcut link name field, enter Start Medical Records Server.

c. From the Program drop-down list, select bin/startWebLogic.cmd (Windows) 
or select bin\startWebLogic.sh (UNIX).

It is not necessary to complete the remaining fields for this example.

To create a Start menu entry for stopping the Medical Records server:

a. Click Add.

b. In the Shortcut link name field, enter Stop Medical Records Server.

Note: Because the applications to be included in this template are 
provided with the product installation, they are not copied into the 
template. Therefore, they are not included in the Applications Root 
Directory list in the Current Template View pane.
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c. From the Program drop-down list, select bin/stopWebLogic.cmd (Windows) 
or select bin\stopWebLogic.sh (UNIX). 

It is not necessary to complete the remaining fields for this example.

Click Next.

12. In the Prepare Scripts and Files with Replacement Variables screen, you can 
replace hard-coded strings with replacement variables in files that have not been 
updated by the Domain Template Builder. The Domain Template Builder 
automatically updates any standard scripts included in a template, such as start 
scripts, by replacing hard-coded values for various domain environment settings 
with replacement variables. The Configuration Wizard can later replace these 
variables with new hard-coded values during the configuration of a new domain.

In this example, it is not necessary to edit any additional scripts or files.

Click Next.

13. On the Review WebLogic Domain Template screen, review the settings for the new 
domain template before it is created. If you need to make changes to any 
configuration information that you specified previously, click Previous to return to 
the required configuration window. 

Click Create.

14. On the Creating Template screen, status messages are displayed during the 
template creation process.

Click Done to close the Domain Template Builder.

5.2 How Do I Create a Custom Extension Template?
The following example shows how to create a custom extension template by 
modifying the Avitek Medical Records Sample Domain extension template provided 
with WebLogic Server. An extension template defines applications and services that 
extend an existing domain. The process for creating an extension template is similar to 
the process for creating a domain template, except that you do not configure the 
Administration Server, assign an administrator username and password, or specify 
Start menu entries, because these domain settings are already defined in the domain to 
be extended.

In this example, you create a customized MedRec extension template in which you 
add support for an additional Medical Records user. Once you have created the 
sample extension template, you can extend an existing WebLogic domain with the 
Medical Records sample domain by selecting your new extension template in the 
Configuration Wizard.

To create a customized MedRec extension template:

1. Start the Domain Template Builder.

■ On Windows, from the Start menu, choose Start > Programs > Oracle 
WebLogic > WebLogic Server > Tools > Domain Template Builder.

■ On UNIX:

– Go to the WebLogic Server /common/bin subdirectory:

cd MW_HOME/wlserver_10.3/common/bin

– Enter the following command: 

sh config_builder.sh
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2. On the Create a New Template screen, select Create a Domain Template, and click 
Next. 

3. On the Select a Template Domain Source screen, select an existing extension 
template or a domain from which to create an extension template. In this example, 
you create an extension template using the Avitek Medical Records extension 
template included in the product installation.

a. Click the Select a Template tab.

A list of the predefined extension templates provided with your product 
installation is displayed in the Templates pane.

b. Select the Avitek Medical Records Sample Domain extension template from 
the list.

c. Click Next.

4. You are using an existing template as the source for the new template; so 
information from the Avitek Medical Records Sample Domain extension template 
is displayed automatically in the Describe the Template screen.

For this example, you do not need to change anything.

Click Next.

5. On the Enter the name and location of the domain template screen, enter the 
following information or accept the defaults:

■ Template jar name—Enter the name you want to use for the template’s JAR 
file, or accept the displayed default, which is based on the name you entered 
on the previous screen.

■ Template location—Accept the default (MW_HOME\user_templates) or enter 
another directory location.

6. On the Add or Omit Applications screen, you can omit applications from the 
extension template and change the relative path of the directory into which 
applications are imported. By default, all the applications included in the source 
are selected, indicating that they will be added to your custom template. 

For this example, you do not need to add or omit any applications.

Click Next.

7. On the Add Files screen, you can add or remove files from the extension template. 
You selected an existing template as the source for your custom template; so all 
files from the source template are also included automatically.

In this example, the Avitek Medical Records Sample Domain extension template 
includes a separately defined applications directory. Therefore, the applications in 
the template are listed under Applications Root Directory in the Current 
Template View pane.

Click Next.

8. On the Add SQL Scripts screen, you can add SQL scripts for each database that 
you expect to use with the domains created from this template.

For this example, you do not need to add any database scripts.

Click Next.

9. On the Security Configurations Options screen, you can customize any security 
settings that are defined in either your domain or the extension template that 
serves as the source for the new extension template.
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Because you are going to define an additional user in this example, select Yes, and 
click Next.

10. On the Configure Users, Groups, and Global Roles screen, you can define users, 
groups, and roles for authentication purposes. The users, groups, and roles 
defined in the template are listed. You can select the Users, Groups, or Roles tab 
to view the current definitions. 

In this example, you will define a new physician and assign the physician to an 
existing group.

a. Select the Users tab.

b. Click Add.

c. Enter the following values:

User Name: joe@md.com

User Password: welcome1

Description: MedRec Physician

By default, the new user is assigned to the Administrators group. In the next 
window, clear this assignment, and assign joe@md.com to the MedRec 
Physicians group.

d. Click Next.

11. On the Assign Users to Groups screen, you can assign users to groups. Oracle 
recommends that you add users to groups, because by managing groups you can 
manage multiple users simultaneously.

In this example, you need to remove joe@md.com from the Administrators group 
and assign to the MedRecPhysicians group.

a. In the Group pane, ensure that the Administrators group is selected.

A list of current assignments for the Administrators group is displayed in the 
left pane.

b. In the left pane, deselect the check box for joe@md.com.

c. In the Group pane, select MedRecPhysicians.

A list of current assignments for the MedRecPhysicians group is displayed in 
the left pane.

d. In the left pane, select the check box for joe@md.com. The list of groups 
associated with joe@md.com is updated to reflect the change.

e. Click Next.

12. On the Assign Groups to Groups screen, you can designate one group as a 
member of another group. In this example, you do not need to change the default 
assignments. 

Click Next.

13. On the Assign Users and Groups to Global Roles screen, you can assign users and 
groups to the global security roles defined by WebLogic Server. In this example, 
you do not need to change the default assignments. 

Click Next.

14. On the Prepare Scripts and Files with Replacement Variables screen, you can 
replace hard-coded strings with replacement variables in files that have not been 
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updated by the Domain Template Builder. The Domain Template Builder 
automatically updates any standard scripts included in a template, such as start 
scripts, by replacing hard-coded values for various domain environment settings 
with replacement variables. The Configuration Wizard can later replace these 
variables with new hard-coded values during the configuration of a new domain.

In this example, it is not necessary to edit any additional scripts or files. Click 
Next.

15. On the Review WebLogic Domain Template screen, review the settings for the new 
extension template before it is created. If you need to modify any of the 
information that you previously defined, click Previous to return to the required 
configuration window. 

Click Create.

16. On the Creating Template screen, status messages are displayed during the 
template creation process. 

Click Done.
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